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Foreword 
The Internet has broken down many global barriers. It provides both the private 
and the corporate community with a whole new networking model. Language skills 
are now a lesser source for concern when it comes to international business and 
personal correspondence. WordFinder Pro helps you and your company to effort-
lessly communicate in different languages. 

WordFinder Pro can, in a split second, display translations, phrases and synonyms 
required in your work. Enter the word to be translated in your word processor! Just 
one click then lets you find and translate the word in question. Double click to paste 
the translation into your document! It could not be easier. 

WordFinder Pro, complete with accompanying dictionaries, offers users much more 
than standard printed dictionaries. As well as saving time and the greater level of 
flexibility, you can avail of the following advanced functions: 

User dictionaries Create user dictionaries with corporate-specific or 
branch-related terminology. 

Dictionary groups Carry out a search in several dictionaries by setting up 
dictionary groups. 

Entry search Search for a phrase or expression. 

Wild card search Carry out advanced searches for word segments using 
wild card characters (* or ?). 

Search in opposite 
language direction 

This function provides you with subtle graduations in a 
language. It allows you to search for a translation in a 
corresponding bilingual dictionary. 

Paste translations You can quickly and easily paste the translation into your 
document. 

Notes This option lets you create notes relating to WordFinder 
Pro dictionaries. 

Import dictionaries Convert your old dictionary databases into the Word-
Finder Pro format.  

WordFinder Pro helps you to use contemporary words and expressions in your doc-
umentation. Our range contains more than 100 different dictionaries in 10 different 
languages that can be integrated with our software. WordFinder Pro runs in all types 
of Windows-based programs such as word processing, spreadsheet and email soft-
ware. 

By signing up for one of our very favourable licensing agreements, you will be guar-
anteed free software upgrades, unbeatable discount prices when buying software in 
the future and free technical support. An annual subscription fee is all that is needed 
to make sure you have the very latest version of our software installed on your com-
puter.  

Browse to our website for more details: www.wordfinder.com. 
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Introduction 

Requirements: 
We recommend that you read this manual prior to installation and when reviewing 
the functions provided in WordFinder Pro. This manual describes version 10. 

A good understanding of Microsoft Windows is required to fully understand the 
contents of this manual. 

Technical specifications 
WordFinder Pro requires: 

 Windows XP or above. 

or 

 Windows 2003 Server or above. 

 Disk with 8 MB free space for the program and 5-20 MB free space for each 
dictionary database.  

Help 
The help section in WordFinder Pro contains all the details you require when ad-
ministrating the software. 

Do as follows to start the help guide: 

1. Select Contents from the ? menu or press F1 to open the help dialog window.  

The Contents section provides support and troubleshooting. It also includes a link 
to WordFinder Software’s website, software details and system information required 
when you contact our customer support staff. The terms of the software license are 
also outlined in this section.  

If you require help 

If you need assistance on how to use Windows help, you can either select How to 
use help in WordFinder Pro’s help menu or press F1 when WordFinder Pro’s help 
section is displayed. 
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How to use WordFinder Pro 

Start WordFinder Pro 
Once installation is complete, you can find the WordFinder Pro program group icon 
in the Start menu under Program, or among the apps in Windows 8.  

The easiest way to start WordFinder Pro is to doubleclick on the WordFinder Pro 
icon on your desktop. If you want WordFinder Pro to start automatically each time 
you start Windows, you have to place the WordFinder Pro icon in Autostart. 

Activate WordFinder Pro 
Once WordFinder Pro has been started, it can be activated at any time by a keyboard 
combination (hotkey) Ctrl+Left Shift or via the taskbar in Windows.  

You can always change the hotkey setting under Tools|Preferences|Configuration. 
If the keyboard combination does not work, it is most likely in use by another active 
application. Reset the shortcut combination until you find one that is not in conflict 
with current hotkeys. 

Quit WordFinder Pro 
WordFinder Pro can be closed in a number of ways: 

 Select Quit from the File menu. 

 Press Alt+F4 when WordFinder Pro is activated. 

 Click the close (x) button on the top right hand corner in the title bar. 
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The program window 
Here is an overview of the program window: 

 
 

1 Menu bar. 

2 Toolbar buttons. 

3 Type your search word here. 

4 Click here to see a list of previous search words. 

5 The name of the active file and word processor is shown here. 

6 Doubleclick here to alter language direction in dictionary/dictionary group. 

7 Headword window: A list of words from a dictionary/dictionary group or a 
particular search list is displayed in this window. 

8 Status bar. The name of the license holder for the dictionary may also be 
displayed here. 

9 Search index window for searching Pinyin/Cn characters. 

10 Entry window showing explanations/translations/synonyms.  

11 Spelling aid window 

12 Click on this icon to browse to WordFinder’s website to see, for instance, if 
any software upgrades are available. 
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Headword window 

The headword window displays headwords from the activated dictionary or diction-
ary groups. If you have carried out a search for a headword, the exact word or the 
closest match will be highlighted in the list shown.   

Place note that when you carry out a wildcard search or use the Search in all entries 
function (refer to How to use WordFinder Pro), the resulting headword list contains hits 
only. The list is empty, however, if the search does not find an entry.  

Entry window 

The entry window displays translation entries for the headword highlighted in the 
headword window. The entry window displays explanations, translations, synonyms 
etc.  

Any word that you would like to use in your document or file is pasted directly from 
the entry window. Pasteable words and phrases are highlighted.   

Tip! 
User notes can be added to entries. Please refer to Create a note under Dictionary Man-
agement.  

How to use WordFinder Pro explains how to carry out searches, paste entries etc. 

For Swedish, English, Spanish, Danish and Norwegian, you can get help in spelling 
certain words, refer to the chapter How to use Word Finder Pro. 

NOTE! 
You can quickly and easily paste a suitable translation from the entry window into 
your document, by pressing Enter or by doubleclicking. Refer to Paste translations.  

Menus and toolbars 
The File menu contains the Minimise and Exit options. 

The Edit menu contains the Copy, Copy special and Paste commands. 

The View menu allows you to select which icons are shown in the toolbar. You can 
choose from Entry Search, User Word, Create a note and Writing Assistance.  

The Tools menu offers various settings and functions. The Program settings menu 
contains a number of options that let you customise WordFinder Pro. Select the 
Dictionary Management menu if you wish to organise your dictionaries. User dic-
tionary passwords and company notes can be modified using the Tools menu. 

The Dictionary menu shows all accessible dictionaries and their corresponding hot-
keys, Ctrl+1 to 9. The same display can also be obtained by using the right mouse 
button anywhere in the WordFinder Pro window. In this menu, you can also select 
any dictionary group you may have created. 

The ?  menu offers help with the software whenever you need it. 
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A number of options are available in the toolbar. 

 

The buttons are divided into different categories by narrow vertical lines. The first 
button lets you transfer any selections to your word processor. This is followed by 
the Normal search category with four buttons.  The next category is Entry search, with 
three buttons. The red button cancels a search. The next category is User word with 
three buttons followed by the note creation button and the button for irregular verbs 
at the far right. 

Below is a summary of the buttons and what they do: 

No. Name Functionality: 

1 Transfer selected word to active 
document 

Paste selected word from Word-
Finder Pro into your word proces-
sor. 

2 Search among headwords Activate a search among headwords. 

3 Search Carry out a search for the word 
shown in or written into the entry 
field. 

4 Continue search in opposite  
language direction. 

Carry out a search in a language in 
any corresponding dictionary. 

5 Search for word in entry window Activate a search among entries. 

6 Search in this entry Carry out a search in the entry 
shown. 

7 Search in all entries Carry out a search among all entries 
in the active dictionary. 

8 Cancel search Cancel ongoing search. 

9 Add Word Add words to user dictionary. 

10 Edit Word Modify words in user dictionary. 

11 Delete Words Remove words from user dictionary. 

12 Create a note Create a note in the displayed entry. 

13 Irregular verbs Open the Irregular verbs window, if 
it is available (otherwise the button is 
not visible). 

If you wish not to use a certain category, then you can remove it from the toolbar,  
by selecting this option under the View menu. 
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Select dictionary/dictionary group 
From the Dictionary menu, you can select a dictionary of your choice.  Here you 
can also select any dictionary groups you may have created. 

The menu is shown in the following screen shot: 

 

Here you can see all the dictionaries installed, including any user dictionaries created, 
categorised according to different language combinations. The active dictionary is 
checked to the left of the dictionary name.  

You can select another dictionary by clicking on its name or by using the defined 
hotkey. 

Select a dictionary group 

Select a dictionary group using the Dictionary|Groups menu. Any groups you may 
have created are then displayed. Below is a screen shot of how this window may 
look: 

 

Click on the dictionary group you wish to select.  

The Dictionary Management section contains more information about dictionary 
groups. 
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Search in WordFinder Pro 
There are a number of search options available when translating content. Select a 
search option that suits your method of working. 

Direct search from other applications 

You can search for a word directly from the application you are using, for example 
Microsoft Word. 

1. Select the word you wish to translate. 

2. Activate WordFinder Pro using the hotkey combination or click on the Word-
Finder Pro icon in the Windows task bar.  

WordFinder Pro searches automatically through the headword index to finally dis-
play explanations, translations, synonyms etc in the entry window.  

3. Paste in the desired word or phrase by double-clicking the word or phrase in 
question. Pasteable words and phrases are highlighted. 

 You can also select a word or phrase and press Enter or click on the Transfer 
selected word to active document button. 

Searching in WordFinder Pro 

1. Activate WordFinder Pro and enter the word you wish to search for in the 
Search field. 

2. Click Enter. 

WordFinder Pro searches for the word to finally display explanations, translations, 
synonyms etc in the entry window.   

3. Paste in the desired word or phrase by double-clicking the word or phrase in 
question. Pasteable words and phrases are highlighted. 

 You can also select a word or phrase and press Enter or click on the Transfer 
selected word to active document button. 

Searching on every key press 

With this option activated, which is standard, words, similar to the headword and 
which are indexed according to the each letter typed into the Search box, are listed 
in the headword window. This is a very practical tool when you are, for instance, 
unsure of how a certain word is spelt.  

This option can be activated and cancelled using the hotkey combination, Ctrl+T. 
You can also activate/deactivate this option as follows: 

1. Activate WordFinder Pro and choose Tools|Program settings|Configuration. 

2. Click on the Functions tab. 

3. Check Search on every key press and click OK. 

When this option is activated, it can be used as follows: 
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1. Enter the word you wish to search for in the Search field. WordFinder Pro 
searches for the word, one letter at a time, according to the order they are en-
tered.  

2. Click Enter when you are finished with the search. 

Searching using a wildcard or joker character 

You can either enter the exact word to be searched for or use either * or ? to repre-
sent a wildcard character. The * character represents one or more real characters. 
The ? character represents any one character. In this way, you can e.g. search for: 

band*  all words beginning with band 

*ready* all words containing the character combination ready. 

*band all words ending in band 

b?ll all words with four letters starting with b and ending with ll. 

1. Enter the word you wish to search for using a wildcard in the Search field. 

2. Press Enter or click on the Search button. 

The program searches for the word and displays a list of headwords in the headword 
window. Here you can select the word you are looking for. Note that searching in 
this manner results in a hitlist with headwords only. The list is empty, however, if 
the search does not find an entry.  

3. Select Search among headwords to return to the standard search mode. 

Entry search 

This is useful when you wish to search for single words or complete phrases in the 
entry section of a dictionary. You can either search in one entry for a specific word 
or in all entries in the dictionary. 

The following explains how to search within a displayed entry: 

1. Enter a word or phrase in the Search field. 

2. Click the Search for word in entry window button. 

3. Click Search in this entry to carry out a search for the word/phrase in this 
entry. 

If the word exists in the entry, all occurrences will be highlighted. 

4. Select Search among headwords to return to the standard search mode. 

The following explains how to search in all entries: 

1. Enter a word or phrase in the Search field. 

2. Click the Search for word in entry window button. 

3. Click Search in all entries to carry out a search for the word/phrase in all en-
tries. 

The headword list is now revised to list all headwords that contain entries with the 
searched word/phrase. 

4. Click on each headword to view the respective search results in the entry. 
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5. Select Search among headwords to return to the standard search mode. 

Search in opposite language direction 

There is, at times, a requirement to carry out a search in a corresponding language 
in a bilingual dictionary in an attempt to define various intonations in a language. 

1. Enter the word you wish to search for in the Search field and press Enter. 

WordFinder Pro searches through the headword index to display words, transla-
tions, synonyms and phrases in the entry window.  You can easily translate any word 
in the hitlist found in the corresponding dictionary.  

2. Place the cursor on the relevant word in the entry window and press the Con-
tinue search in opposite language direction button in the toolbar to translate 
it. By right clicking on a word, you can also carry out a search for its translation. 

3. The translation of the word is now shown in the entry window in the corre-
sponding dictionary. Click Return to close this window to return to the previous 
entry window. 

Dictionary group search 

When you carry out a search in a dictionary group for a word or phrase, WordFinder 
Pro searches for the word or phrase in all the dictionaries in the group. The resulting 
search list contains the word or phrase you searched for.  

With the default settings, the Compress headwords in dictionary groups option 
under Tools|Program settings|Configuration is active, which means the headword 
is displayed only once, instead of the exact number of times it appears in the various 
dictionaries. The entry window displays each occurrence of the headword from the 
grouped dictionaries it is indexed in. 

 

I you change that setting, the number of hits corresponds to the number of times 
the word/phrase occurs in the dictionaries in your group. An explanation for each 
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occurrence of the word is displayed in the entry window if you scroll down the list 
of hits.  

 

Refer to Dictionary Management on how to group dictionaries. 

Paste translations 
You can quickly and easily paste a suitable translation from the entry window into 
your document. Do as follows: 

1. Search for the required entry using a search option described above. 

Highlighted words in the entry window can be pasted into your document as follows: 

2. Click Enter. 

You can browse the list of pasteable words/phrases in the entry window using the 
Arrow right and Arrow left keys. In this way, you can browse to the word or phrase 
you wish to paste and then press Enter. 

You can also paste in a highlighted word or phrase of your choice as follows: 

2. Doubleclick on the word or phrase. 

The translation is pasted into your document. Any selected words in your document 
will be replaced by the pasted word. If you have not selected a word in your docu-
ment, the translation will be inserted at the position of the cursor. 
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Browse in headword or entry window 
It is important that the correct area of the WordFinder Pro program window is active 
if you wish to browse in either the headword or entry window. 

The Search field is active when you type in a word or phrase. In this case, you can 
only browse in the headword or entry window using the scrollbar. 

When you enter the word or phrase and press Enter, the headword window be-
comes active and you can browse in this window and the entry window using the 
arrow keys. Arrow up, Arrow down, Page Up and Page Down in the headword 
window and Arrow left and Arrow right in the entry window. 

If you use a scroll mouse, the headword window has to be first activated before you 
can scroll the list using the scroll wheel. When the cursor points at the headword 
window, you can use the scroll wheel to browse the list, whereas if the cursor points 
to the entry window, you can scroll here instead. 

Changing language direction 
Current language direction settings are shown, at all times, in the program window. 
The flag icons to the right of the active file/program field indicate language direc-
tion. Below is a screen shot of how this window may look: 

 

Change language direction, i.e. change to corresponding language in a bilingual dic-
tionary by doubleclicking on the flags icon. 

Copy special 
In certain cases, you may wish to copy more information than is normally the case 
when pasting from an entry. This is where the Copy special feature comes in handy. 
Do as follows: 

1. Select the required headword. 

2. Select Edit|Copy special. 

The complete entry for this headword is now displayed in a new window, e.g. 
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3. Select the content you wish to copy. 

NOTE! 
You can only copy a maximum of 200 characters at a time. If you select more than 
200 characters, a warning message highlighted in red will appear. 

4. Click Copy to clipboard or Transfer to word processor. 

If you copy the content to the clipboard, you can paste it into the document of your 
choice in any application. If you choose to transfer the content to your word pro-
cessor, it will be pasted directly at the cursor in the active document in the back-
ground. 

Spelling aid 
For Swedish, English, Spanish, Danish and Norwegian, you can get help in spelling 
certain words. This feature is designed to help you find the correct word even if the 
entry is not spelled correctly. 

In the spelling aid window, you will find suggestions for words that sound the same 
as the search word and that are in the dictionary. You open and close the spelling 
aid window by clicking on the triangle at the bottom corner of the article window. 

 

When the spelling aid window is open, it may look like this: 
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In the index window, the marking may have different hues depending on whether 
or not the search word matches it 100%. If you enter a word that is not in the dic-
tionary, the next word in the dictionary is presented. This word is highlighted with a 
light purple colour to indicate that it is not a 100% match. If there is a 100% match, 
the colour is dark purple.  

This is how it looks when a match is not 100%: 

 

This is how it looks when a match is 100%: 

 

Irregular verbs 
When the target language is Swedish, English, German, Italian, Spanish or French, 
conjugation tables are available for the most common irregular verbs. If a conjuga-
tion table is available, this icon is shown in the row of buttons: 

 

You can use this function in two ways: 

1. Click on the icon in the tool bar. 

Now an empty conjugation table is displayed. 

2. Click the drop-down arrow under Search verb at the bottom left and select a 
verb in the list. 

Now a conjugation table for the verb is displayed. 
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3. Click on the conjugated form you wish to use and click on Paste. 

If you click on a word in the article window that has a conjugation table, an icon 
immediately appears in the article window. This is how it may look: 

 

1. Click on the icon, and the conjugation window opens with conjugations for the 
selected irregular verb. 

2. Click on the conjugated form you wish to use and click on Paste. 

Regardless of how you open the conjugation window, you can search the dictionary’s 
conjugation table. You can search all conjugated forms. Do as follows: 

1. Enter the search word in the box under Verb search. 

2. Click on Search. 

The conjugation table containing that word is displayed. If the search word is not 
listed in the conjugation table, the box will flash red. 

3. Click on the conjugated form you wish to use and click on Paste. 
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Search among Pinyin/Cn characters (Simplified Chi-
nese characters) 
In WF10 you can work with dictionaries of Pinyin/Cn characters. When you have 
such a dictionary you can choose to display either Pinyin or Cn characters in the 
index window, or both at the same time.  

When this type of dictionary is activated, the search index window is displayed where 
you can make this choice. This is how it may look: 

 

You can close and open this window by clicking on the triangle. 

 

How to use the search index window: 

At Search index, select whether you wish to search among Pinyin or Cn characters. 
Check boxes appear during Display. If you want both character forms displayed in 
the index window, both boxes should be checked. If you only want one of them 
displayed, check its box and make sure the other box is not checked. 
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Some information about how the search function works 

Accents for the first and third tones are not available on Swedish or English key-
boards. You cannot, for example, have two accents on the same letter.  

Since it is difficult with a normal keyboard to enter pinyin words with "tone marks", 
the program checks via an internal table whether what has been entered can be Pin-
yin (ma, zhi, jing, yo, etc.) If so, the search is switched first to the Chinese-English 
direction and results in a wildcard search of, for example, ma* where all pinyin (ma 
regardless of "tone marks") hits are displayed in the index list. The program also 
automatically switches to pinyin-sorting.  

You should always divide each pinyin with a space, for example m�m�hūhū is 
written ma ma hu hu. 

If you instead search for map (which is not included in the internal pinyin table), it 
is interpreted as an English word and then the program automatically switches to 
the English-Chinese direction. 

Of course, you can search directly for pinyin words with "tone marks" or Cn char-
acters if you enter them in the search field via hotkeys or the scrapbook. In both 
cases, the program automatically switches to the Chinese direction and to the re-
spective sorting (pinyin or Cn characters). This search is done in the usual way with-
out the wildcard technique. 

Limitations 

When you work with dictionaries containing Pinyin/Cn characters or Japanese char-
acters, there are some limitations in Word Finder. The following features are not 
available when using dictionaries with Chinese or Japanese: 

 User dictionaries 

 Notes 

 Glossary test 

 Copy special 

 Easy Reader. 
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Configure WordFinder Pro 
Under Tools|Program settings|Configuration, you can modify WordFinder Pro 
to suit your working environment. This section covers features relating to the con-
figuration of the software, as well as menu language and password options.  

Configuration 
The Configuration dialog window contains 4 tabs: 

 

Start up/Activation 

Activation (Hotkey) 
Here you can define which keyboard combination should be used to activate (dis-
play) WordFinder Pro. The default key combination (Hotkey) is Left Ctrl+Left 
Shift (displayed as CTRL+SHIFT above).  

The keyboard combination must consist of either the Alt or Ctrl key followed by 
one or two user-defined keys. Examples of correct hotkeys are Alt+Shift+F2 and 
Ctrl+W, while Shift+F3 is incorrect. 

To change a current activation key combination, place the cursor in the Hotkey 
field and then press the key combination you want.  

NOTE! 
You cannot enter the different parts of your key combination separately e.g. Alt 
followed by F10. You must first press the Alt key, and without releasing it, then 
press the F10 key.  

If you would like to activate WordFinder Pro from the taskbar, select the Activate 
from taskbar option. 
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Start up 
Uncheck Show start screen if you do not want to display the WordFinder Pro 
splash screen when the program starts.  

You can decide to start the program in minimised mode, making it available in the 
background as an icon in the taskbar. If this is the case, check the Start minimised 
option. The program appears as the WordFinder Pro icon in the taskbar.  

You can activate WordFinder Pro by either clicking on the WordFinder Pro icon in 
the taskbar or by keying in the hotkey combination. 

Functions 

This tab contains the following options: 

 

Search/paste 
The first option here allows you to include a space after each pasted word or phrase. 
You can also set WordFinder Pro to carry out searches after each key press (Incre-
mental search). It is also possible to deactivate the clipboard in Word 2000. 

Text size in percent of standard size. 
Variable adjustment of text size in WordFinder Pro.  
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Effects 

This tab contains the following: 

 

It is possible, in a pleasant fashion, to fade in and out both the WordFinder Pro 
program window and the Writing Assistance dialog. Select Fade in and fade out to 
activate this option. In the case of Writing Assistance, it is also possible to set the 
delay time before the dialog window is displayed after you have stopped writing, as 
well as the deactivation delay time once you begin writing again. 

In WordFinder Pro you can choose the appearance of WordFinder Pro’s program 
window and dialogue windows. You can choose to have the WordFinder appearance 
or the Windows standard appearance.  

Use the Colours option to set background colours in the entry window. Searched 
words will be highlighted in this background colour. Select Reset colours to return 
to default settings. 

Entry display 

The following options are available on this tab. 

 

Compress index in dictionary groups 
Once you have created dictionary groups, you can choose to display the search re-
sults in compressed programmed form or uncompressed form. Compressed form is 
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standard. You activate or deactivate the feature by selecting Display head word 
only. In compressed form, a headword indexed in several dictionaries is displayed 
only once, instead of the exact number of times it appears in the various dictionaries. 
Refer to How to use WordFinder Pro to learn how the software interacts with installed 
or user dictionaries. 

Display cross-references 
If you carry out a search for an irregular verb in WordFinder Pro, the corresponding 
entry contains a link or cross-reference to the infinitive form.  Clicking on this link 
takes you to a description of the infinitive verb form. Check Automatic search for 
first cross-reference in entry, if you however would like to include this description 
with an entry when a search is carried out. 

The following screen shot shows this feature if this option is not checked: 

 

The following screen shot shows this feature if this option is checked: 
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Language 
Under Tools|Program settings|Language, you can select which menu language 
to use in WordFinder Pro. All menus and the working interface are altered. 

Change password 
If you password protected a user dictionary or a company note, select this menu to 
alter each password. 

Dictionaries 

Do as follows to reset a user dictionary password. 

1. Select the dictionary for which you wish to alter the password. 

2. Open Tools|Change password|Dictionary.  

3. Enter the current password and click OK.  

4. Enter the new password and click OK.  

5. Confirm the new password by entering it again and click OK.  

Company notes 

Do as follows to reset a company note password. 

1. Find the word linked to the note. 

2. Open Tools|Change password|Company note. 

3. Enter the current password and click OK.  

4. Enter the new password and click OK.  

5. Confirm the new password by entering it again and click OK.  
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Dictionary management 
The Dictionary Management menu contains all the necessary dictionary setting 
options: 

Shortcut commands 
The following dialog window opens when you select Shortcut commands: 

 

Dictionaries 

This tab allows you to define hotkeys for nine different dictionaries. 

When you have set these shortcut commands, you can easily alternate between dic-
tionaries by using these hotkeys instead of opening the Dictionary menu.  

Do as follows to define a shortcut command for a dictionary: 

1. Decide which command you want to use. 

2. Click on the drop-down list button to the right of the field. 

3. Select a dictionary from the list. 

4. Click Save when you have defined all shortcut commands. 
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Groups 

This tab allows you to define hotkeys for nine different dictionary groups. 

 

When you have set these shortcut commands, you can easily alternate between dic-
tionary groups by using these hotkeys instead of opening the Dictionary|Groups 
menu.  

Do as follows to define a shortcut command for a dictionary group: 

1. Decide which command you want to use. 

2. Click on the drop-down list button to the right of the field. 

3. Select a dictionary group from the list. 

4. Click Save when you have defined all shortcut commands. 
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File paths to dictionaries 
Here you can enter the file paths to the folders where your dictionaries are stored. 

 

The list can contain up to 20 different file paths. Do as follows to include a file path. 

1. Click on the folder icon. 

2. Browse to and select a folder that contains a dictionary.  

3. Click OK. 

The file path is now shown in the text field. From here you either add the path as a 
new file path or replace a file path already listed. 

Do as follows to add the file path: 

4. Click Add. 

If, on the other hand, you wish to replace a file path, do as follows: 

4. Select the file path to be replaced. 

5. Click Replace. 

Do as follows to remove a file path from the list: 

1. Select the file path to be removed. 

2. Click Delete. 

When you are finished modifying the file path list, the Dictionary menu is updated 
in line with these changes. 
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Dictionary groups 
This option allows you to group dictionaries that have the same linguistic base. The 
Dictionary groups function is an invaluable tool when you work with a large num-
ber of dictionaries. By merging those that belong to similar groups, you spend less 
time alternating between dictionaries, offering a better view of the dictionaries avail-
able.  

NOTE! 
It is important that you select dictionaries that have the same basic language struc-
ture when creating a group, i.e. the same alphabetical sorting for letters, if grouping 
is to work effectively. 

How searching groups works is defined in How to use WordFinder Pro. 

Selecting Dictionary groups opens a dialog window with essential information. 
Check the Do not display this message again box if you do not want to display 
this window each time you create a group. Click OK to continue. 

The dictionary group dialog window may look as follows: 

 

Create a dictionary group 

Do as follows to create a dictionary group: 

1. Click on Create new group.  

2. Enter the name of the group in the Group box. If you would like to create a 
group with, for example, Swedish-English dictionaries, a suitable group name 
would be Swe-Eng Dictionary.  

3. Click Apply. 

4. Choose the dictionaries from the dictionary list to be included in the group by 
doubleclicking those you require.  



 

© 2014 WordFinder Software International AB Dictionary management 29 

or: 

4. You can select more than one dictionary at a time by using the Shift and Ctrl 
keys as used normally in Windows. Click on the upper arrow button when you 
are finished with your selection. 

The selected dictionaries are then transferred to the Dictionary in group field. If 
you transferred any dictionaries by mistake, they can easily be removed from the 
Dictionary in group list by either doubleclicking them or by selecting and then 
clicking on the lower arrow button located between the list fields. 

NOTE! 
If the red warning light by Dictionary’s sorting index incorrect flashes, an unsuit-
able dictionary combination has been set up, so the dictionary group has to be re-
vised. 

5. Use the dictionary sequence arrows to the right of Dictionary sequence to alter 
the order of dictionaries in the group. Select the dictionary to be moved and 
click on the required arrow to move it up or down the list. The sequence here 
defines the order in which the dictionaries are searched. 

6. Click Apply. 

Your dictionary group is now available under the Dictionary|Groups menu. You 
can define hotkeys for any groups you have created. Refer to Shortcut commands above. 

The How to use WordFinder Pro section describes how to carry out a search using a 
dictionary group. 

Modify a dictionary group 

Do as follows to modify any group you have created. 

1. Select the group to be modified from the drop-down menu under Group. 

The dictionaries contained in this group are now listed in the Dictionary in group 
box. Dictionaries can be added to or removed from this list as outlined above when 
a new group is created. 

2. Modify as required.  

3. Click Apply. 

Remove a dictionary group 

Do as follows to remove a dictionary group: 

1. Select the group to be removed from the drop-down menu under Group. 

The dictionaries contained in this group are now listed in the Dictionary in group 
box.  

2. Make sure that this is the correct dictionary to be removed. 

3. Click Remove group. 

4. Confirm removal of the group by clicking Yes (or No to prevent removal). 
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User dictionaries 
All organisations use in-house terminology that is not available in standard diction-
aries. You can now create your own branch-related and/or corporate-specific dic-
tionary using WordFinder Pro. The software can easily be applied to the creation of 
other databases such as address books, telephone directories, product listings, etc. 
User dictionaries are listed under the Dictionary menu in submenus based on de-
fined language combinations. 

Create your own dictionary as follows: 

1. Select Tools|Dictionary Management|User dictionaries.  

A submenu contains the options available to manage your dictionaries. 

New dictionary 

Do as follows to create a new user dictionary. 

1. Select Tools|Dictionary Management|User dictionaries|New dictionary  from 
the menu or press F4. 

2. Specify the file path to your new dictionary, i.e. define the folder where the dic-
tionary is stored. The program suggests the file path where any other dictionaries 
are stored. The file path can also be set by the network administrator.  

3. Define the language direction by selecting languages from the menus under 
From and To.  

4. Enter a file name in the File name field. The first four characters in the file 
name cannot be changed, as these are based on the defined language combina-
tion,  

It may look like this: 

 

5. Continue by clicking Next. 

The following window is displayed: 
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6. Enter a suitable name for your dictionary. 

7. Enter the name of the owner, which is optional. 

The name cannot contain more than 50 characters. The dictionary name is shown 
in WordFinder Pro's window title bar and in the Dictionary menu, where you can 
select which dictionaries are activated. 

8. Continue by clicking Next. 

The following window is displayed: 

 

9. Select a sorting index based on the language your dictionary will be sorted in.  

NOTE! 
The software proposes a suitable sorting index depending on the language combi-
nation that has been selected. Normally, you can accept the proposed index. 

10. You can password protect your new dictionary by checking the Password pro-
tection box. This means that if any changes or additions are made to the dic-
tionary, the password is required to do so.  

11. If you would like to create a new dictionary using a template, check the Link to 
template box. 

NOTE! 
If you use a template to define a dictionary, all entries in the dictionary will be defined 
by the fields and formatting set in the template. You cannot undo a link to a tem-
plate, but changes can be made to the template, to words you have added to the 
dictionary and any other dictionaries based on the template. Refer to Templates for 
more details. 

12. Press OK to finish creating your new dictionary. 
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Import dictionaries 
It is possible to create a customised dictionary in WordFinder Pro, e.g. a specific 
dictionary that includes in-house company terminology or branch-related terminol-
ogy. Please also refer to Batch-add words on how to import an Excel file. 
A dictionary can be imported into WordFinder Pro by implementing the following 
steps: Select Tools|Dictionary Management|User dictionaries|Import dictionary. 

These dictionaries have the following format: 

 Text in ANSI-format. 

 Entries should not be more than a maximum of 40 characters in width. 

 The headword must be written on a separate line and enclosed by a @. An 
empty line should be included before every headword with the exception of the 
first one. 

 Words and phrases that can be pasted by WordFinder Pro into your word pro-
cessor have to be enclosed by a > and a < character. 

An example of what an ANSI file for import looks like: 

@alls@ 
>at all<; ingenting ~ >nothing 
whatever<, >nothing at all<; inget 
besvär ~ >no trouble whatever<, >no 
trouble at all<; inte ~ trött >not at 
all tired<, >not a bit tired< 
 
@allseende@ 
>all seeing< 

If you have created a dictionary in a different program, export it from your program 
as an ANSI text file. Change its format in an editor or a conversion program so that 
the file looks like the one above and that the required control codes are used as 
outlined in Control codes for importing dictionaries into WordFinder Pro below. Import your 
dictionary into WordFinder Pro. 

The following dialog is shown when importing a dictionary: 
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1. Enter the name and file path of the file to be imported in the From import file 
box. You can also define the file path and file by selecting the Open button. 

2. In the Import to dictionary field, state the dictionary into which you wish to 
import the data. If you would like to use one of your own dictionaries, select it 
from the user dictionary dropdown list. You can also create a new dictionary at 
this point by selecting the New dictionary option. 

3. Start importing by clicking the Start button. 

If the dictionary in question was empty prior to importing, it will contain imported 
data once the import procedure is complete. If the dictionary was not empty previ-
ously, the imported data will be merged with the data already stored in the dictionary. 

Control codes for importing dictionaries into  
WordFinder Pro 
The following is a list of all the control codes that can be used. 

Text formatting control codes 

Character Explanation 

!K Italics on 

!k Italics off 

!F Bold on 

!f Bold off 

!R Cross-referencing on (hyperlink to index with green underline) 

!r Cross-referencing off 

!E Exponent on (superscripted character with compressed text) 

!e Exponent off 
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!I Index on (subscripted character with compressed text) 

!i Index off 

!S07 Compressed text on, font size, 8 points 

!s Compressed text off 

> Paste on 

< Paste off 

!> Writes character > without making it pasteable 

!< Writes character < 

| (Alt+124) Line break in entry 

!B Image on (file path + file name defined) 

!b Image off 

!M Activate red font colour 

!m Deactivate red font colour 

!G Activate strikethrough 

!g Deactivate strikethrough 

!N00..!N15 Alternate font colour, active until turned off.  

!N00 Black font 

!N01 Red font 

!N02 Green font 

!N03 Blue font 

!N04 Yellow font 

!N05 Fuchsia font 

!N06 Purple font 

!N07 Maroon font 

!N08 Lime font 

!N09 Aqua font 

!N10 Teal font 

!N11 Navy font 

!N12 White font 

!N13 Lt Grey font 

!N14 Grey font 

!N15 Black font 

!n Turn off font colour and return to black. 

!O Turn on Ignore paste option 
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!o Close Ignore paste option 

Changing fonts 

Character Explanation 

!An Alternate font, active until turned off. 

A1 Arial 

A2 Times New Roman 

A3 Courier New 

A4 SILDoulus IPA93 

A5 TWA Phonetics 

A6 Wingdings 

A7 Symbol 

Export dictionaries 
You can export dictionaries from WordFinder Pro via Tools|Dictionary Manage-
ment|User dictionaries|Export dictionary. If you want to create a document of your 
dictionary, you can choose to export the dictionary in Column format. 

The following dialog is shown when exporting a dictionary: 

 

1. Select the dictionary you want to export from the Export dictionary list. Open 
the drop-down menu and select the required dictionary. 

2. The program suggests a filename in the To Text file field based on the name 
of the dictionary being exported. It also adds the suffix TXT e.g. 
USERWORD.TXT. You can however change the file path and file name for 
the text file that is being created. 

3. If you do not want to import the file into WordFinder Pro again, check the The 
export file is created in column format box. 
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4. Start the export by clicking the Start button.  

The exported file is saved in your selected folder. You can open the file in a word 
processor, edit it and ultimately print it. 

Reorganise a dictionary 
Working with user dictionaries for longer periods of time can create empty space 
that can affect the performance of large dictionaries. It is now possible to reorganise 
the dictionary to remove these redundant spaces. 

Select Tools|Dictionary Management|User dictionaries|Reorganise a dictionary.  

The following window is displayed: 

  

1. Open the drop-down menu and select the required dictionary. 

The dictionary now appears in the Dictionary field. 

2. Click Start to reorganise the dictionary.  

If, however, you wish to cancel this operation, click Return to stop the reorganisa-
tion process. When the reorganisation process is finished, a dialog opens to display 
how many search words have been reorganised. 

3. Continue by clicking Return.  

Delete dictionaries 
User dictionaries can be removed from WordFinder Pro by selecting Tools|Dic-
tionary Management|User dictionaries|Delete dictionary.  

The following window opens: 
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4. Select the dictionary to be removed in the Delete field. Open the drop-down 
menu and select the required dictionary. 

The File name field displays the files contained in the dictionary. It is these files 
that will be removed. 

5. Click Delete to remove the dictionary. Note that you cannot delete a dictionary 
that is in use. 

If, however, you wish to cancel this operation, click Return to stop the deletion 
process. 

Add Words 
Do as follows to add new words to a user dictionary: 

1. Choose the dictionary you want to add a word to. 

2. Click Add word. 

You can also choose Tools|Dictionary Management|User dictionaries|Add 
word or press the Insert key. 

3. Enter the new headword in the New headword and entry field.  

 

4. In the box for explanatory text under the formatting toolbar, enter the text to 
be shown in the entry window.  The box works as a simple word processing 
program. Format the text using the available menus and buttons. 
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You can choose from the following formatting options: 

 

No. Name Functionality

1 Font Select from a limited number of fonts. 

2 Font size Select either 11 or 8 points. 

3 Font colour Select from a limited number of colours. 

4 Paste Make content pasteable. 

5 Bold Bold style 

6 Italics Italics 

7 Underline  
(cross-reference) 

Underlined style. Used also to create a cross-
reference hyperlink to a word/phrase. 

8 Superscript Superscript format, e.g. m2. 

9 Subscript Subscript format, e.g. H2O. 

10 Strikethrough Strikethrough format 

11 Image Insert a link to a BMP formatted image. A sym-
bol is used in entries to indicate that there is an 
image linked into the entry content. To see the 
image, just click on the symbol in the entry win-
dow. 

12 Line break Insert a line break. 

13 Hyperlink Turn the selected URL into a hyperlink.  

When you are finished formatting the entry, do as follows: 

5. Click Apply. 

Now you can insert another headword in the same way. Do as follows to close the 
dialog window when you have added all headwords. 

6. Click OK. 

Click Cancel if you want to close the dialog window without saving your changes. 

Batch-add words 
Use this option if you wish to add a large number of new words or import an Excel 
list of words. Do as follows to add new words to a user dictionary: 

1. Choose the dictionary you want to add a word to. 

2. Select Tools|Dictionary management|User dictionaries|Serieinmatning or 
press Ctrl+Insert. 

The following window is displayed: 
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Here you can enter the words in the table and format them or import an Excel file 
containing a word list. Every time you save, the words inserted in the table are added 
to your dictionary. If you add or import a duplicate word, it is also added to the 
dictionary. Existing words are not replaced. 

If for some reason you would like to delete all the words in the table, then click on 
Delete all. 

Enter words directly 

You can add up to 300 words without saving (but we do recommend that you save 
more often). Do as follows: 

1. Enter the search word in the New word field. 

2. Enter entry content for the search word in the Entry text box. The box func-
tions as a simple word processing program. Format the text using the available 
buttons. Press Enter to insert a line break. 
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You can choose from the following formatting options: 

 

No. Name Functionality

1 Font Select from a limited number of fonts. 

2 Font size Select either 11 or 8 points. 

3 Font colour Select from a limited number of colours. 

4 Paste Make content pasteable. 

5 Bold Bold style 

6 Italics Italics 

7 Underline  
(cross-reference) 

Underlined style. Used also to create a cross-refer-
ence hyperlink to a word/phrase. 

8 Superscript Superscript format, e.g. m2. 

9 Subscript Subscript format, e.g. H2O. 

10 Strikethrough Strikethrough format 

11 Hyperlink Turn the selected URL into a hyperlink.  

When you are finished adding and formatting the entry, just continue with the next 
one. Do as follows to save a word that you have added: 

3. Click Save. 

4. Continue by clicking Return when you are finished. 

Import an Excel file 

It is possible to import an Excel file where the entries are inserted in the A column 
and the entry text in the B column. The file can contain up to 300 words. If the 
Excel file contains more than 300 words, it will have to be divided into smaller files 
that are imported separately.  

Entry content can be formatted using the control codes for importing dictionaries 
(as outlined earlier). Imported words can also be formatted in the same way as de-
scribed in the section about direct insertion above. 

Do as follows to import an Excel file: 

1. Revise the Excel file, if required, so that it only includes the words that are to 
be imported. 

2. Click on Import Excel file. 

3. Browse to the Excel file in the Open dialog and select it. Continue by clicking 
Open. 

The content in the Excel file is now imported into the table. 

4. Use the toolbar to further format the content if required. 

5. Click Save. 
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6. Continue by clicking Return when you are finished. 

Edit Words 
Do as follows to edit a word or an entry in a user dictionary: 

1. Click on the headword if it is not already selected.  

2. Click the Edit word button. 

You can also choose from the menu Tools|Dictionary Management|User dic-
tionaries|Edit word or press F3. 

The headword and entry are shown and you can edit the text as described in the Add 
word section. You can also rename the dictionary.  

3. Click OK when editing is complete to save the changes to the dictionary. 

Edit entry content on the fly 

Any errors in entry content for a word in a user dictionary can be quickly revised 
directly in the entry window. Password protected dictionaries require however a 
password to edit the content. 

Do as follows when the entry content is displayed in the entry window: 

1. Press F3. 

The entry window is transformed into edit mode.  

2. Make any required changes. Content can be edited as described in the Add words 
section above.  

3. Click OK to save changes or Cancel to undo any changes. 

Delete Words 
Do as follows to remove a headword: 

1. Click on the headword if it is not already selected. 

2. Click Delete word button. 

You can also choose Tools|Dictionary Management|User dictionaries|Delete word 
or press the Delete key. 

A dialog window opens as follows: 

 

3. Click Yes if you want to delete the word or No to keep it in the dictionary. 
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Templates 
How content and colour schemes are defined for entries in a user dictionary can be 
set by a template that has a predefined structure and format. User dictionary tem-
plates are created by selecting 

Tools|Dictionary Management|User dictionaries|Templates. 

You can choose from the following options: 

 

Create a template 

Do as follows to create a new template: 

1. Click on New template. 

2. Enter a suitable name for your template. Note that when a template-based dic-
tionary is exported, the proposed name for the export file is based on the name 
of the original template. It is therefore important to refrain from using unusual 
characters in the template name. 

3. Click Save template. 

The template is now visible in the Template list. Continue by defining a structure 
for the entry window. You can use any standard text format. Using the formatting 
toolbar, you can insert entry text fields or pasteable entry text fields, as well as apply 
format to both text and fields. 

You can choose from the following options: 

 

No. Name Functionality

1 Font Select from a limited number of fonts. 

2 Font size Select either 11 or 8 points. 

3 Font colour Select from a limited number of colours. 

4 Bold Bold style 

5 Italics Italics 

6 Insert field Insert field for entering text.  

7 Insert paste field Insert field for pasteable text. 
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You can work in any order you like. The following shows an example of how this 
process of creating a template may look: 

1. Enter prompt texts for fields. 

The dialog window may look as follows when you are finished: 

 

2. Place the cursor where you would like to insert the first field and then click on 
the button for this field type.  In the example shown here, a pasteable field has 
been inserted for the top three prompt texts, while the last prompt refers to a 
standard text field. 

When a field is inserted or selected, a new dialog window opens where you can de-
fine field length and tab order settings. It is also possible to delete the field at this 
point. Below is a screen shot of how this window may look: 
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Click on the arrows to the right of the field length to define how many characters 
can be entered in the field. The Use field ID option lets you set tab order, where A 
is the first field, B the second and so on.  

A selected field can always be removed by clicking Delete. 

3. Define field length and tab order. 

4. Add in the remaining fields as required. 

The dialog window may look as follows when you are finished: 
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The top three fields, which are pasteable, are denoted by capital letters, while the last 
field, which is not pasteable is specified by lower-case letters. 

If you wish to edit fonts, font size, colour or format style, select the content and 
click on the required button in the toolbar. If you want to change the format of a 
field, the entire field has to be selected. 

Text can be erased by pressing the Backspace or Delete key. 

Continue as follows once the template is finished: 

5. Click Save. 

When inserting new words and phrases in user dictionaries that are template-based, 
the template defines what you can work with. The following dialog window shows 
how the template we have created may look: 
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Enter a word or phrase in the New headword or entry field in the same way as 
with a standard user dictionary, but in this case, content and how the different fields 
in the entry are formatted is completely defined by the template. Here all buttons in 
the toolbar are greyed out. 

You can browse forward between fields by pressing the Tab key or backward by 
pressing Shift+Tab. Pasteable fields are highlighted with bold angle brackets. Com-
pare the upper three fields with the bottom non-pasteable field. 

Edit a template 

Contents in an existing template can be edited as follows: 

1. Select Tools|Dictionary Management|User dictionaries|Templates. 

2. Select the template you wish to edit from the Template list. 

The existing template is displayed. All content and fields can be edited in the same 
way as described above when defining a new template.  

3. Modify as required. 

NOTE! 
If a field is removed, it is essential that this field is not linked to any information in 
a dictionary based on this template. If you remove a field in use by dictionaries based 
on this template, you will not be able to access these dictionaries. 

4. Click Save. 

Changes in a template influence all entries in all user dictionaries based on this tem-
plate. 
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Delete a template 

A template not in use can easily be deleted.  

1. Select Tools|Dictionary Management|User dictionaries|Templates. 

2. Select the template you wish to delete from the Template list. 

The existing template is displayed.  

3. Make sure that this is the correct template to be deleted. 

NOTE! 
It is essential to make sure that the template is not being used by a dictionary. If a 
template, being used by a dictionary, is deleted, the dictionary will not function. 

4. Click Delete template. 

5. Click Yes to confirm deletion or No if you do not wish to delete the template. 

Export a template 

A template can be exported to a file to make it accessible to other users who can 
import it into their WordFinder Pro program. Do as follows to export: 

1. Select Tools|Dictionary Management|User dictionaries|Templates. 

2. Select the template you wish to export from the Template list. 

The existing template is displayed.  

3. Make sure that this is the correct template to be exported. 

4. Click Export template. 

In the following dialog window, enter a name for the file and browse to where it is 
to be saved. 

5. Enter a file name. Make sure that the file suffix is not altered. It has to be in 
TPL format. 

6. Open the folder where the file will be saved. 

7. Click Save. 

Import a template 

A template created by another user can be imported into your program. Do as fol-
lows to import a template: 

1. Select Tools|Dictionary Management|User dictionaries|Templates. 

2. Click on Import template. 

Browse for the file in the dialog window that opens. 

3. Open the folder that contains the template file. 

4. Select the template file to be imported. 

5. Continue by clicking Open. 

Repeat this procedure if there are more templates that you wish to import. 
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NOTE! 
Templates must have unique file names. If you import a template with the same 
name as a template in your computer, you will be asked if you wish to replace the 
current template. Answer Yes or No depending whether or not you want to replace 
the existing template in use by WordFinder Pro. 

Create a note 
Use the Create note button if you would like to include a note with an entry in a 
dictionary of your choice.  

1. Select the headword you wish to create a note for. 

2. Click Create a note in the toolbar. 

You can also select Tools|Dictionary Management|Create a note or press Ctrl+Q. 

The following window is displayed: 

 

3. Enter the entry note and select a suitable text colour. Different types of notes 
can be highlighted with different colours. 

4. If this is the first time a note is created, the program prompts you to create a 
note file. Confirm this by clicking Yes. 

Under the Advanced menu, you can define whether notes are accessible only to you 
or to the entire company as a company note.  

A Personal note is individual for each user and is saved locally on the user's com-
puter. 

A Company note can be read by all network users. This type of note is password 
protected and is stored in a network folder. The network administrator has to enter 
another file path for this folder in the WFSYSTEM.INI. file, which is stored in the 
folder where WordFinder Pro was installed. 
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5. Click Save. An icon has been created to indicate a note exists for this entry. 
Note that the colour of the pin in the note corresponds to the initial colour you 
selected. 

Read note 

1. Find the word and the entry that includes the note. 

2. Click on the note icon to view the note. 

You can also read the note when the cursor is placed over the note. 

Edit note 

1. Find the word and the entry that includes the note. 

2. Right click on the note icon. 

3. Select Edit.  

4. Make the required changes in the note and press Save. 

Delete note 

1. Find the word and the entry that includes the note. 

2. Right click on the note icon. 

3. Select Delete.  

4. Confirm the removal of the note. 

Glossary test 
Challenge relatives, friends and colleagues to a word game or learn new words using 
the program’s glossary test! 

Select Tools|Dictionary managment|Glossary test. 

The following window is displayed: 
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1. Begin by deciding whether you want to use a purchased or user dictionary. Do 
not forget that it is very easy to create your own dictionary where you can include 
the glossary list you want to test. 

2. Open the drop-down menu and select the dictionary you want to use. 

3. Make any settings changes as your require. 

In Manual mode, you have to click on Next word to browse to the next word in 
the dictionary and click on Show entry to display entry content (explanation). The 
Auto mode browses automatically through words and explanations at a speed in 
seconds set by you. 

Word sequence can de defined either according to the order in the dictionary or at 
random and you can also set the test to display clues. 

4. In Manual mode, click Next word followed by Show entry once you or your 
test rivals have tried to guess a word.  

or: 

4. If you have selected Auto, click Start to initiate the test and Stop to stop the 
test. Select Restart if you want to start the test again. If you feel that the test 
runs too fast, you can easily slow it down by increasing the number of seconds 
in the delay box. 

5. Close the dialog window when you are finished with the test. 
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Shortcut commands 
Press To 

Ctrl+Left Shift Activate WordFinder Pro. NOTE! Can be modified in 
Program settings. 

Alt+F4 Exit WordFinder Pro when it is active. 

Ctrl+n Select a dictionary. Dictionary hotkeys are Ctrl+n, where n 
= 1 to 9. The hotkeys are defined by selecting Tools|Dic-
tionary Management|Shortcut commands. 

Ctrl+Alt+n Select a dictionary group. Dictionary group hotkeys are 
Ctrl+Shift+n, where n = 1 to 9. The hotkeys are defined 
by selecting Tools|Dictionary Management|Shortcut com-
mands. 

Ctrl+A Entry search. 

Ctrl+F3 Open the Edit words dialog. 

Ctrl+G Open the dialog window for dictionary groups. 

Ctrl+Insert Open the Batch-add dialog window. 

Ctrl+L Open the dialog window for shortcut commands. 

Ctrl+P Open the settings dialog window. 

Ctrl+T Turns the search after each key press function on or off. 

Ctrl+Q Create a note 

Delete Remove headwords from active user dictionaries. 

End Jumps to the last word in the list of headwords. 

Enter Search for headword entered by a user. 

or 

Pastes the word or phrase, highlighted in the entry window, 
into your document 

Esc Minimise WordFinder Pro. 

F1 Start Windows Help and help topics for WordFinder Pro 

F3 User dictionaries: Edit entry. The edit mode dialog opens in 
the entry window. 

F4 User dictionaries: New dictionary 

Home Jump to the first word in the list of headwords. 

Insert Add headwords to active user dictionaries. 

Arrow right Browse to the right in the entry window 

Arrow left Browse to the left in the entry window 

Page Down Scrolls down one page in the list of headwords. 
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Page up Scrolls up one page in the list of headwords. 

Arrow down Scrolls down the list of headwords one word at a time.  If 
the Search box is selected, browse down the history list 
one word at a time. 

Arrow up Scrolls up the list of headwords one word at a time.  If the 
Search box is selected, browse up the history list one word 
at a time. 

Shift+F10 Show Dictionary menu. 

Tab Alternate between Search box and the headword window.  

 

 


